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INTISARI

Telah dilakukan penelitian identifikasi sebaran dan ketebalan pasir besi daerah
pantai glagah indah Sidorejo, Temon, Kabupaten Kulon Progo D.I Yogyakarta
dengan menggunakan metode geomagnetik. Penelitian ini bertujuan untuk
mengetahui nilai anomali medan magnet total, arah penyebaran pasir besi dan
ketebalan pasir besi berdasarkan interpretasi pemodelan struktur bawah permukaan.
Pengambilan data dilakukan selama tiga hari dengan luas area 5 km X 2.5 km dengan
spasi 500 m menggunakan alat Proton Precision Magnetometer (PPM). Pengolahan
data dilakukan dengan koreksi harian, koreksi IGRF, kontinuasi ke atas, reduksi ke
kutub dan pemodelan struktur bawah permukaan. Hasil nilai anomali medan magnet
total -300 nT hingga 400 nT, nilai -300 nT hingga 299 nT menunjukkan adanya
alluvium atau batuan yang terubahkan seperti lempung, lumpur, pasir dan kerikil,
nilai 300 nT sampai 400 nT diperkirakan terdapat keberadaan pasir besi karena
berkaitan dengan batuan bersifat magnetik yang berasal dari hasil rombakan batuan
gunung api berupa batuan beku yang telah mengalami pelapukan seperti batuan
breksi vulkanik yang telah mengalami proses mineralisasi sehingga mengandung
mineral-mineral oksidasi besi seperti magnetit dan hematit, persebaran dari pasir besi
relatif mengarah ke barat hingga utara dengan arah N 1800 E hingga N 3600 E karena
di pengaruhi oleh beberapa faktor yaitu aliran sungai, gelombang laut dan angin, dan
ketebalan dari pasir besi pada slice AA’ 4 meter hingga 6 meter dan pada slice BB’
ketebalan pasir besi 6 meter.
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BAB I

PENDAHULUAN

1.1 Latar Belakang

Indonesia merupakan salah satu negara yang memiliki Sumber Daya

Alam (SDA) yang besar. Salah satu SDA yang melimpah di Indonesia

adalah besi. Besi dapat dimanfaatkan oleh manusia sebagai bahan

pendukung pembangunan fisik seperti gedung, jembatan, perumahan, dan

jalan raya. Besi juga sebagai salah satu bahan baku utama dalam industri

baja dan industri alat berat (Yulianto, dkk.2003). Di dalam surat Al-Hadid

ayat 25, Allah SWT berfirman :

                   
             
             

Artinya : Sesungguhnya Kami telah mengutus Rasul-rasul Kami dengan

membawa bukti-bukti yang nyata dan telah Kami turunkan bersama mereka

Al kitab dan neraca (keadilan) supaya manusia dapat melaksanakan

keadilan. dan Kami ciptakan besi yang padanya terdapat kekuatan yang

hebat dan berbagai manfaat bagi manusia, (supaya mereka mempergunakan

besi itu) dan supaya Allah mengetahui siapa yang menolong (agama)Nya dan

rasul-rasul-Nya Padahal Allah tidak dilihatnya. Sesungguhnya Allah Maha

Kuat lagi Maha Perkasa.Q.S Al- Hadid (57): 25 (Tafsir Al Qurthubi,2009)
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Pada surat Al- Hadid ayat 25 Allah telah menciptakan besi yang

memberikan manfaat dan kehebatan yang luar biasa sebagai bukti Maha

Besar Allah SWT. Dengan adanya besi kita dapat merasakan kehidupan yang

lebih baik dan mengubah peradaban manusia menuju lebih baik dengan

dibuktikan semakin pesatnya perkembangan teknologi dan informasi yang

merupakan salah satu manfaat dari besi yang telah digambarkan oleh Allah

pada ayat tersebut.

Pada zaman rosulullah besi dimanfaatkan dalam pembuatan baju

perang, tetapi di zaman sekarang besi dapat dimanfaatkan dalam banyak hal

hampir seluruh industri. Logam besi digunakan sebagai bahan baku dalam

industri baja, selain itu digunakan sebagai bahan campuran semen, bahan

dasar tinta kering pada mesin fotokopi dan printer laser. Salah satu bahan

baku logam besi dapat berupa pasir besi dengan mineral yang terdiri dari

mineral logam magnetit, titaniferous magnetit, ilmenit, limonit dan hematite

yang bercampur dengan mineral nonlogam seperti, kuarsa, kalsit, feldspar,

ampibol, piroksen, biotit, dan tourmalin. Bahan baku logam besi yang

digunakan secara terus menerus akan habis, untuk menjaga kesinambungan

industri tersebut diperlukan pencarian bahan baku besi. Bahan baku besi

dapat berupa pasir besi yang terdapat pada kabupaten Kulon Progo.

Kabupaten Kulon Progo merupakan salah satu kabupaten dari Propinsi

Daerah Istimewa Yogyakarta yang terletak di bagian barat. Batas Kabupaten

Kulon Progo di sebelah timur yaitu Kabupaten Bantul dan Kabupaten

Sleman, di sebelah barat berbatasan dengan Kabupaten Purworejo, Propinsi
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Jawa Tengah, disebelah utara berbatasan dengan Kabupaten Magelang,

Propinsi Jawa Tengah dan di sebelah selatan berbatasan dengan Samudera

Hindia. Geologi regional ini adalah dataran alluvial dan satuan dataran pantai

(Subsatuan gumuk pasir dan subsatuan dataran alluvial pantai) (Van

Bemellen, 1948). Sungai-sungai yang mengalir di daerah pantai selatan

khususnya daerah sekitar Kulon Progo berhulu dari gunung api yang

berkomposisi andesitik, seperti Gunung api Merapi, Gunung api Merbabu,

Gunung api Sumbing, dan Gunung api Sindoro. Batuan gunung api atau

batuan vulkanik memiliki komposisi yang mengandung besi (Fe). Kandungan

Fe akan lebih besar pada batuan vulkanik yang bersifat andesitik dan basaltik.

Kandung Fe pada batuan tersebut berupa mineral mafik seperti olivine,

piroksen, hornblend, biotit, magnetit dan ilmenit. Ketika batuan ini

mengalami pelapukan secara fisik, batuan ini akan mengalami disintegrasi

menjadi fragmen bahkan hingga berupa butiran-butiran mineral dari mineral

penyusunan. Beberapa di antaranya berupa butiran mineral magnetit dan

ilmenit. Sedangkan akibat pelapukan kimia mineral penyusun batuan tersebut

akan mengalami perubahan secara kimia berupa terurainya unsure atau

senyawa tertentu. Karena batuan ini mangandung Fe, maka aka nada unsur Fe

yang dihasilkan dari proses pelapukan. Fe tersebut selama transportasi bisa

mengalami reaksi dengan kandungan oksigen yang terdapat dalam air

menghasilkan mineral baru berupa hematite dan limonit. Di daerah pantai

selatan Kabupaten Kulon Progo, Provinsi Daerah Istimewa Yogyakarta (DIY)

terdapat endapan pasir yang keberadaannya cukup melimpah. Keberadaannya
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dikatakan sepanjang 22 km dari hilir Sungai Bogowonto sampai hilir Sungai

Progo dengan cadangan sebesar 605 juta ton. (Rusianto,dkk, 2012).

Pada daerah timur Sungai Serang terdapat eksplorasi pasir besi oleh

PT. Jogja Magasa Iron, karena pada daerah kawasan pesisir pantai selatan

kulonprogo terdapat pasir besi yang berwarna abu-abu kehitaman

menunjukan adanya kandungan magnetik dalam jumlah besar, komposisi

kimia pasir besi terdiri dari mineral besi utama berupa magnetit (Fe3O4),

hematite (Fe2O3), ilmenit (FeTiO3), dan mineral pengotor berupa corumndum

(Al2O3), kuarsa (SiO2), vanadium (V2O5), fosfor (P) dan sulfur (S)

(Satria,2014).

Gambar 1.1 Daerah eksplorasi pasir besi PT. Jogja Magasa Iron (JMI)

Berdasarkan peta diatas daerah timur sungai serang merupakan daerah

eksplorasi PT.JMI dan daerah barat sungai serang merupakan daerah

penelitian karena sebelah barat sungai serang belum dilakukan eksplorasi oleh

sehingga perlu dilakukan penelitian mengenai pasir besi di barat sungai

Serang untuk mengetahui anomali medan magnet, arah penyebaran dan

ketebalan dari pasir besi. Terdapat beberapa metode geofisika yang dapat
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digunakan untuk survei awal eksplorasi seperti metode gravitasi, metode

geolistrik, metode polarisasi terinduksi, metode vlf dan metode geomagnetik.

Salah satu metode geofisika yang dapat digunakan untuk mengetahui sebaran

mineral logam adalah metode geomagnetik. Metode geomagnetik adalah

salah satu metode geofisika yang digunakan untuk menyelidiki kondisi bawah

permukaan bumi dengan memanfaatkan sifat kemagnetan batuan yang

diidentifikasikan oleh kerentanan magnet batuan. Oleh karena itu dalam

penelitian ini menggunakan metode geomagnetik yang memanfaatkan sifat

kemagnetan batuan yang sangat efektif dalam mencari pasir besi yang

termasuk kedalam ferromagnetik dan dengan menggunakan metode

geomagnetik ini dapat menginterpretasikan mineral logam dengan baik dan

diharapkan dapat memberikan informasi arah penyebaran dan ketebalan atau

kedalaman pasir besi di area penelitian.

1.2 Rumusan Masalah

Dari latar belakang di atas, dapat dirumuskan masalah-masalah dalam

penelitian ini yaitu:

1. Bagaimana sebaran anomali medan magnetik pada daerah barat Pantai

Glagah Indah?

2. Bagaimana arah penyebaran pasir besi di daerah barat Pantai Glagah

Indah?

3. Berapakah ketebalan dari pasir besi di daerah timur Pantai Glagah Indah?
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1.3 Tujuan Penelitian

Tujuan dari penelitian ini adalah :

1. Mengetahui sebaran anomali medan magnet total pada daerah barat Pantai

Glagah Indah.

2. Mengetahui arah penyebaran pasir besi pada daerah barat Pantai Glagah

Indah.

3. Mengetahui ketebalan dari pasir besi pada daerah barat Pantai Glagah

Indah.

1.4 Batasan Masalah

Batasan masalah dalam penelitian ini adalah :

1. Lokasi penelitian dilakukan di daerah timur Pantai Glagah Indah Kel.

Sidorejo, Kec. Temon, Kab. Kulon Progo, D.I Yogyakarta dengan

koordinat -7.916875° dan 110.076690° sampai dengan -7.900179° dan

110.032609°, -7.861744° dan 110.048508° sampai dengan -7.878432°

dan 110.092589°.

2. Penelitian menggunakan metode geomagnetik dengan pengambilan data

secara looping.

3. Penelitian ini hanya mengetahui sebaran anomali medan magnet,

mengamati arah penyebaran dan ketebalan pada daerah lokasi penelitian

berdasarkan metode geomagnetik.

4. Lokasi penelitian dilakukan di daerah barat Pantai Glagah Indah Kel.

Sidorejo, Kec. Temon, Kab. Kulon Progo, D.I Yogyakarta.
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1.5 Manfaat Penelitian

Manfaat yang diperoleh dari penelitian ini adalah

1. Menambah khasanah keilmuan dengan metode geomagnetik pada jurusan

Fisika UIN Sunan Kalijaga.

2. Menambah pengetahuan tentang pasir besi dengan metode geofisika

terutama metode geomagnetik.

3. Hasil yang diperoleh dapat digunakan sebagai informasi bagi berbagai

pihak dalam eksplorasi pasir besi.
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BAB V

KESIMPULAN

5.1 Kesimpulan

Berdasarkan penelitian “Identifikasi Sebaran Dan Ketebalan Pasir Besi

Daerah Pantai Glagah Indah Sidorejo, Temon, Kabupaten Kulon Progo D.I

Yogyakarta Dengan Menggunakan Metode Geomagnetik” dapat diambil

kesimpulan sebagai berikut :

1. Sebaran anomali medan magnet total pada daerah pantai glagah indah

menunjukan nilai anomali berkisar dari nilai -300 nT hingga 400 nT, nilai-

300 nT hingga 299nT menunjukkan dengan batuan yang bersifat

nonmagnetik (diamagnetik) seperti alluvium atau batuan yang terubahkan

seperti lempung, lumpur, dan pasir kerikil. Nilai 300nT hingga 400 nT

memungkinkan adanya pasir besi karena berkaitan dengan batuan bersifat

magnetik yang berasal dari hasil rombakan batuan gunung api berupa batuan

beku yang telah mengalami pelapukan atau alterasi tingkat sedang sampai

tinggi, seperti batuan breksi vulkanik yang telah mengalami proses

mineralisasi sehingga mengandung mineral-mineral oksidasi besi seperti

magnetik dan hematit.

2. Persebarandaripasirbesirelatifmengarahkebarathinggautaradenganarah N

1800 Ehingga N 3600 E yang dapatdilihatdaripersebarannilaimedanmagnet

total yang telah di reduksi ke kutub menandakan keberadaan pasir besi yang
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di pengaruhi oleh beberapa faktor yaitu,aliran sungai, gelombang laut dan

angin.

3. Ketebalan pasir besi berdasarkan pemodelan 2 ½ D terlihat bahwa pada

slice aa’ ketebalan dari pasir besi 4 meter hingga 6 meter dan pada slice

bb’ketebalan dari pasir besi 6 meter.

5.2 Saran

Perlu dilakukan penelitian lebih lanjut dengan menggunakan metode

geofisika yang lain seperti metode polarisasi terinduksi dan geolistrik.
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LAMPIRAN 1

Data Hasil Pengukuran

Nomor Nomor Patok
Koordinat

Time Medan magnet
Latitude Longitude

1 Base -7.91082 110.0825 9:53:57 45160.8
9:54:06 45186.1
9:54:13 45195.1

2 1 -7.90403 110.082 10:20:00 45157
10:20:00 45161
10:20:59 45125

3 2 -7.90238 110.0776 10:51:00 45057.1
10:51:12 45059.8
10:51:21 45075.6

4 3 -7.90073 110.0733 11:16:11 45234.8
11:16:22 45275.9
11:16:32 45280.5

5 4 -7.89905 110.0688 11:29:43 45096.5
11:29:51 45094.6
11:30:01 45083.1

6 5 -7.89738 110.0644 11:37:31 45024.3
11:37:40 45024.9
11:37:48 45044.4

7 6 -7.89573 110.06 11:46:19 45351.1
11:46:26 45354.5
11:46:34 45364.2

8 7 -7.8941 110.0556 11:55:55 45088.9
11:56:05 45008.3
11:56:13 45031.7

9 8 -7.89237 110.0511 12:52:04 45089.9
12:52:15 45091.9
12:52:22 45130

10 9 -7.8907 110.0467 13:11:48 45018.8
13:11:59 45026.1
13:12:08 45021.7

11 10 -7.88903 110.0423 13:22:06 45148.7
13:22:14 45153
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13:22:22 45147.8
12 11 -7.88737 110.0379 13:31:35 45025.4

13:31:43 45033
13:31:50 45022.7

13 12 -7.89163 110.0361 13:44:59 45007
13:45:06 45004.6
13:45:16 45002

14 13 -7.8933 110.0406 13:54:25 45256.3
13:54:34 45254
13:54:44 45247.5

15 14 -7.89498 110.045 14:04:28 45390.6
14:04:36 45406.7
14:04:45 45388.5

16 15 -7.8965 110.0494 14:24:57 45358.8
14:25:14 45360
14:25:24 45383.6

17 16 -7.89832 110.0538 14:38:56 44941.4
14:39:06 44957.9
14:39:15 44944.4

18 17 -7.89998 110.0582 14:49:14 44939.7
14:49:26 44986.9
14:49:35 44972.9

19 18 -7.90165 110.0626 14:54:45 44970.4
14:54:56 44952.6
14:55:04 44959.7

20 19 -7.90322 110.067 15:03:48 45005.7
15:03:58 45012.3
15:04:17 45006.1

21 20 -7.905 110.0714 15:15:27 44802.3
15:15:35 44809.2
15:15:42 44816.1

22 21 -7.90667 110.0758 15:23:01 44896.5
15:23:11 44898.3
15:23:23 44916.5

23 22 -7.90833 110.0802 15:23:34 45016.5
15:28:01 45026.9
15:28:11 45009.9

24 Base -7.91082 110.0825 15:35:49 45129.6
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25 Base -7.91082 110.0825 9:41:20 45435.7
9:41:33 45412.3
9:41:39 45118.1

26 23 -7.90963 110.0785 10:12:08 45166.1
10:12:25 45167.2
10:12:39 45173.3

27 24 -7.90927 110.074 10:22:33 45052.2
10:22:48 45048.8
10:23:02 45046.9

28 25 -7.90922 110.0696 10:38:38 44977.2
10:38:47 44983.1
10:38:56 44978.2

29 26 -7.9076 110.0652 11:04:48 45087.6
11:04:56 45081.8
11:05:07 45082.1

30 27 -7.90592 110.0608 11:35:56 45012.4
11:36:08 45023
11:36:18 45029.2

31 28 -7.90427 110.0564 12:05:26 45170.6
12:05:40 45142.8
12:05:50 45157.3

32 29 -7.90258 110.052 12:20:23 45048.4
12:20:32 45042.2
12:20:43 45039.7

33 30 -7.90009 110.0476 12:36:06 45251.1
12:36:32 45273
12:36:41 45292.7

34 31 -7.89925 110.0432 13:36:05 45180.9
13:36:19 45184.3
13:36:32 45180.4

35 32 -7.89758 110.0388 13:47:53 45059.1
13:48:02 45065.4
13:48:12 45068

36 33 -7.8959 110.0344 14:04:33 45008.9
14:04:43 45002.8
14:04:52 45013.4

37 34 -7.90018 110.0326 15:09:21 44951.8
15:09:31 44943.5
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15:09:41 44945.2
38 35 -7.90185 110.037 15:29:03 45016.1

15:29:12 45005.3
15:29:21 45013.4

39 36 -7.90352 110.0414 15:38:21 44852
15:38:31 44845.1
15:38:41 44819.8

40 37 -7.90498 110.0458 15:49:03 45037.7
15:49:15 45070.2
15:49:25 45053.9

41 38 -7.90686 110.0502 16:00:08 45005.9
16:00:16 45008.7
16:00:25 45008.3

42 39 -7.9082 110.0546 16:09:27 45051.5
16:09:39 45068.4
16:09:49 45066.6

43 40 -7.90988 110.0591 16:19:12 44997.9
16:19:21 44969.4
16:19:33 44967.9

44 41 -7.91155 110.0635 16:35:45 44912.5
16:35:57 44992.1
16:36:11 44903.8

45 42 -7.91345 110.0679 16:46:51 44920.5
16:47:00 44912.5
16:47:10 44912.4

46 43 -7.9152 110.0723 17:24:19 44971.8
17:24:35 44959.2
17:24:43 44967.5

47 44 -7.91687 110.0767 17:38:02 44823
17:38:11 44820.6
17:38:23 44848.2

48 Base -7.91082 110.0825 18:04:29 45128.9
18:04:38 45145
18:04:46 45145.1

49 Base -7.88653 110.1101 9:28:05 45316.8
9:28:21 45046.4
9:28:33 45050.5

50 60 -7.88545 110.0592 9:55:48 45116.9
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9:55:57 45112.6
9:56:06 45097

51 59 -7.88387 110.0547 10:19:06 45102
10:19:15 45134.3
10:19:24 45123.5

52 58 -7.8825 110.0501 10:47:13 45144
10:47:29 45145.8
10:47:47 45131.8

53 57 -7.8806 110.0459 11:00:40 45107.9
11:00:49 45191.7
11:00:58 45108.6

54 56 -7.87882 110.0415 11:13:48 45128.2
11:13:58 45124.4
11:14:08 45120

55 55 -7.88307 110.0397 11:30:46 45163.9
11:30:54 45162.2
11:31:04 45163

56 54 -7.88477 110.0441 11:43:06 45171.7
11:43:27 45172.6
11:43:36 45192.5

57 53 -7.88642 110.0486 11:55:36 45145.3
11:56:48 45587.8
11:56:58 45615.7

58 52 -7.8881 110.0529 12:02:52 45207.9
12:03:06 45205.8
12:03:16 45200

59 51 -7.88978 110.0574 12:12:06 45276.9
12:12:20 45282.1
12:12:31 45287.5

60 Base -7.88653 110.1101 12:54:55 45596.8
12:55:45 45620.3
12:55:56 45658.1

61 Base 7.886533 110.1101 12:54:55 45596.8
12:55:45 45620.3
12:55:56 45658.1

62 61 -7.88717 110.0635 13:11:57 45206.5
13:12:11 45120.2
13:12:23 45161.5
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63 62 -7.88887 110.0679 13:24:11 45037.3
13:24:33 45129.1
13:24:33 45109.8

64 63 -7.89072 110.0723 13:37:23 45158.5
13:37:34 45173.2
13:37:44 45153.3

65 64 -7.89203 110.0768 13:55:01 45119.9
13:56:12 45128.3
13:55:22 45141.6

66 65 -7.89383 110.0812 14:13:11 45068.8
14:13:23 45155.9
14:13:30 45166.7

67 66 -7.89553 110.0856 14:33:26 45059.1
14:33:36 45039
14:33:45 45028

68 45 -7.8998 110.0838 15:18:43 45080.4
15:19:03 45096.3
15:19:13 45112

69 46 -7.89807 110.0794 15:47:28 45192.4
15:47:38 45004
15:48:09 45189

70 47 -7.89643 110.075 16:04:40 44969
16:04:51 44958.4
16:05:01 44968.3

71 48 -7.89477 110.0706 16:18:00 44855
16:18:29 44849.7
16:18:41 44846.6

72 49 -7.89312 110.0661 16:32:59 45054
16:33:04 45040.2
16:33:22 45036.5

73 50 -7.89143 110.0617 16:42:15 45010.2
16:42:29 45028.4
16:42:36 45017.3

74 Base -7.88653 110.1101 16:49:25 45309
16:49:42 45003.3
16:49:58 45000.4
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LAMPIRAN 2

Data Hasil Perhitungan Anomali Medan Magnet

Nomor Nomor
Patok

Koordinat
Time T rata-

rata
Medan
magnet

Medan
magnet Rata-

rata

Variasi
Harian IGRF Anomali

TotalLatitude Longitude

1 Base -7.91082 110.0825 9:53:57 9:54:05 45160.8 45180.66667
9:54:06 45186.1
9:54:13 45195.1

2 1 -7.90403 110.082 10:20:00 10:20:20 45157 45147.66667 -3.08848 45128.2 22.55515
10:20:00 45161
10:20:59 45125

3 2 -7.90238 110.0776 10:51:00 10:51:11 45057.1 45064.16667 -6.71961 45128.2 -57.31372
10:51:12 45059.8
10:51:21 45075.6

4 3 -7.90073 110.0733 11:16:11 11:16:22 45234.8 45263.73333 -9.68256 45128.2 145.21590
11:16:22 45275.9
11:16:32 45280.5

5 4 -7.89905 110.0688 11:29:43 11:29:51 45096.5 45091.4 -11.27126 45128.2 -25.52873
11:29:51 45094.6
11:30:01 45083.1

6 5 -7.89738 110.0644 11:37:31 11:37:40 45024.3 45031.2 -12.18918 45128.2 -84.81081
11:37:40 45024.9
11:37:48 45044.4

7 6 -7.89573 110.06 11:46:19 11:46:26 45351.1 45356.6 -13.22216 45128.2 241.62216
11:46:26 45354.5



84

11:46:34 45364.2
8 7 -7.8941 110.0556 11:55:55 11:56:04 45088.9 45042.96667 -14.35583 45128.2 -70.87750

11:56:05 45008.3
11:56:13 45031.7

9 8 -7.89237 110.0511 12:52:04 12:52:13 45089.9 45103.93333 -20.96364 45128.2 -3.30302
12:52:15 45091.9
12:52:22 45130

10 9 -7.8907 110.0467 13:11:48 13:11:58 45018.8 45022.2 -23.28720 45128.2 -82.71279
13:11:59 45026.1
13:12:08 45021.7

11 10 -7.88903 110.0423 13:22:06 13:22:14 45148.7 45149.83333 -24.49474 45128.2 46.12807
13:22:14 45153
13:22:22 45147.8

12 11 -7.88737 110.0379 13:31:35 13:31:43 45025.4 45027.03333 -25.61141 45128.2 -75.55525
13:31:43 45033
13:31:50 45022.7

13 12 -7.89163 110.0361 13:44:59 13:45:07 45007 45004.53333 -27.18834 45128.2 -96.47832
13:45:06 45004.6
13:45:16 45002

14 13 -7.8933 110.0406 13:54:25 13:54:34 45256.3 45252.6 -28.30173 45128.2 152.70173
13:54:34 45254
13:54:44 45247.5

15 14 -7.89498 110.045 14:04:28 14:04:36 45390.6 45395.26667 -29.48182 45128.2 296.54849
14:04:36 45406.7
14:04:45 45388.5

16 15 -7.8965 110.0494 14:24:57 14:25:12 45358.8 45367.46667 -31.90475 45128.2 271.17142



85

14:25:14 45360
14:25:24 45383.6

17 16 -7.89832 110.0538 14:38:56 14:39:06 44941.4 44947.9 -33.54118 45128.2 -146.75881
14:39:06 44957.9
14:39:15 44944.4

18 17 -7.89998 110.0582 14:49:14 14:49:25 44939.7 44966.5 -34.75591 45128.2 -126.94408
14:49:26 44986.9
14:49:35 44972.9

19 18 -7.90165 110.0626 14:54:45 14:54:55 44970.4 44960.9 -35.40316 45128.2 -131.89683
14:54:56 44952.6
14:55:04 44959.7

20 19 -7.90322 110.067 15:03:48 15:04:01 45005.7 45008.03333 -36.47275 45128.2 -83.69391
15:03:58 45012.3
15:04:17 45006.1

21 20 -7.905 110.0714 15:15:27 15:15:34 44802.3 44809.2 -37.83328 45128.2 -281.16671
15:15:35 44809.2
15:15:42 44816.1

22 21 -7.90667 110.0758 15:23:01 15:23:11 44896.5 44903.76667 -38.73027 45128.2 -185.70305
15:23:11 44898.3
15:23:23 44916.5

23 22 -7.90833 110.0802 15:23:34 15:26:35 45016.5 45017.76667 -39.12974 45128.2 -71.30359
15:28:01 45026.9
15:28:11 45009.9

24 Base -7.91082 110.0825 15:35:49 15:35:58 45129.6 45140.43333
25 Base -7.91082 110.0825 9:41:20 9:41 45435.7 45322.03333

9:41:33 45412.3
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9:41:39 45118.1
26 23 -7.90963 110.0785 10:12:08 10:12 45166.1 45168.86667 -11.19452 45128.2 51.86119

10:12:25 45167.2
10:12:39 45173.3

27 24 -7.90927 110.074 10:22:33 10:22 45052.2 45049.3 -14.96228 45128.2 -63.93771
10:22:48 45048.8
10:23:02 45046.9

28 25 -7.90922 110.0696 10:38:38 10:38 44977.2 44979.5 -20.75588 45128.2 -127.94411
10:38:47 44983.1
10:38:56 44978.2

29 26 -7.9076 110.0652 11:04:48 11:04 45087.6 45083.83333 -30.24274 45128.2 -14.12392
11:04:56 45081.8
11:05:07 45082.1

30 27 -7.90592 110.0608 11:35:56 11:36 45012.4 45021.53333 -41.53996 45128.2 -65.12669
11:36:08 45023
11:36:18 45029.2

31 28 -7.90427 110.0564 12:05:26 12:05 45170.6 45156.9 -52.24112 45128.2 80.94112
12:05:40 45142.8
12:05:50 45157.3

32 29 -7.90258 110.052 12:20:23 12:20 45048.4 45043.43333 -57.64405 45128.2 -27.12260
12:20:32 45042.2
12:20:43 45039.7

33 30 -7.90009 110.0476 12:36:06 12:36 45251.1 45272.26667 -63.40342 45128.2 207.47009
12:36:32 45273
12:36:41 45292.7

34 31 -7.89925 110.0432 13:36:05 13:36 45180.9 45181.86667 -85.10578 45128.2 138.77245
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13:36:19 45184.3
13:36:32 45180.4

35 32 -7.89758 110.0388 13:47:53 13:48 45059.1 45064.16667 -89.36087 45128.2 25.32754
13:48:02 45065.4
13:48:12 45068

36 33 -7.8959 110.0344 14:04:33 14:04 45008.9 45008.36667 -95.40418 45128.2 -24.42914
14:04:43 45002.8
14:04:52 45013.4

37 34 -7.90018 110.0326 15:09:21 15:09 44951.8 44946.83333 -118.89275 45128.2 -62.47391
15:09:31 44943.5
15:09:41 44945.2

38 35 -7.90185 110.037 15:29:03 15:29 45016.1 45011.6 -126.02752 45128.2 9.42752
15:29:12 45005.3
15:29:21 45013.4

39 36 -7.90352 110.0414 15:38:21 15:38 44852 44838.96667 -129.40260 45128.2 -159.83073
15:38:31 44845.1
15:38:41 44819.8

40 37 -7.90498 110.0458 15:49:03 15:49 45037.7 45053.93333 -133.28917 45128.2 59.02250405
15:49:15 45070.2
15:49:25 45053.9

41 38 -7.90686 110.0502 16:00:08 16:00 45005.9 45007.63333 -137.29253 45128.2 16.72587
16:00:16 45008.7
16:00:25 45008.3

42 39 -7.9082 110.0546 16:09:27 16:09 45051.5 45062.16667 -140.68573 45128.2 74.65240
16:09:39 45068.4
16:09:49 45066.6



88

43 40 -7.90988 110.0591 16:19:12 16:19 44997.9 44978.4 -144.21586 45128.2 -5.58413
16:19:21 44969.4
16:19:33 44967.9

44 41 -7.91155 110.0635 16:35:45 16:35 44912.5 44936.13333 -150.22695 45128.2 -41.83970
16:35:57 44992.1
16:36:11 44903.8

45 42 -7.91345 110.0679 16:46:51 16:47 44920.5 44915.13333 -154.23032 45128.2 -58.83634
16:47:00 44912.5
16:47:10 44912.4

46 43 -7.9152 110.0723 17:24:19 17:24 44971.8 44966.16667 -167.83734 45128.2 5.80401
17:24:35 44959.2
17:24:43 44967.5

47 44 -7.91687 110.0767 17:38:02 17:38 44823 44830.6 -172.78919 45128.2 -124.81080
17:38:11 44820.6
17:38:23 44848.2

48 Base -7.91082 110.0825 18:04:29 18:04 45128.9 45139.66667
18:04:38 45145
18:04:46 45145.1

49 Base -7.88653 110.1101 9:28:05 9:28:19 45316.8 45137.9
9:28:21 45046.4
9:28:33 45050.5

50 60 -7.88545 110.0592 9:55:48 9:55:57 45116.9 45108.83333 64.94162 45128.2 -84.30828
9:55:57 45112.6
9:56:06 45097

51 59 -7.88387 110.0547 10:19:06 10:19:15 45102 45119.93333 119.73448 45128.2 -128.00115
10:19:15 45134.3
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10:19:24 45123.5
52 58 -7.8825 110.0501 10:47:13 10:47:30 45144 45140.53333 186.15205 45128.2 -173.81872

10:47:29 45145.8
10:47:47 45131.8

53 57 -7.8806 110.0459 11:00:40 11:00:49 45107.9 45136.06667 217.44733 45128.2 -209.58066
11:00:49 45191.7
11:00:58 45108.6

54 56 -7.87882 110.0415 11:13:48 11:13:58 45128.2 45124.2 248.36383 45128.2 -252.36383
11:13:58 45124.4
11:14:08 45120

55 55 -7.88307 110.0397 11:30:46 11:30:54 45163.9 45163.03333 288.21437 45128.2 -253.38103
11:30:54 45162.2
11:31:04 45163

56 54 -7.88477 110.0441 11:43:06 11:43:23 45171.7 45178.93333 317.53737 45128.2 -266.80403
11:43:27 45172.6
11:43:36 45192.5

57 53 -7.88642 110.0486 11:55:36 11:56:27 45145.3 45449.6 348.27100 45128.2 -26.87100
11:56:48 45587.8
11:56:58 45615.7

58 52 -7.8881 110.0529 12:02:52 12:03:04 45207.9 45204.56667 363.84027 45128.2 -287.47361
12:03:06 45205.8
12:03:16 45200

59 51 -7.88978 110.0574 12:12:06 12:12:19 45276.9 45282.16667 385.56150 45128.2 -231.59483
12:12:20 45282.1
12:12:31 45287.5

60 Base -7.88653 110.1101 12:54:55 12:55:32 45596.8 45625.06667
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12:55:45 45620.3
12:55:56 45658.1

61 Base 7.886533 110.1101 12:54:55 12:55:32 45596.8 45625.06667
12:55:45 45620.3
12:55:56 45658.1

62 61 -7.88717 110.0635 13:11:57 13:12:10 45206.5 45162.73333 -36.99584 45128.2 71.52918
13:12:11 45120.2
13:12:23 45161.5

63 62 -7.88887 110.0679 13:24:11 13:24:25 45037.3 45092.06667 -64.25464 45128.2 28.12131
13:24:33 45129.1
13:24:33 45109.8

64 63 -7.89072 110.0723 13:37:23 13:37:34 45158.5 45161.66667 -93.49051 45128.2 126.95717
13:37:34 45173.2
13:37:44 45153.3

65 64 -7.89203 110.0768 13:55:01 13:55:32 45119.9 45129.93333 -133.45195 45128.2 135.18529
13:56:12 45128.3
13:55:22 45141.6

66 65 -7.89383 110.0812 14:13:11 14:13:21 45068.8 45130.46667 -173.07977 45128.2 175.34644
14:13:23 45155.9
14:13:30 45166.7

67 66 -7.89553 110.0856 14:33:26 14:33:35 45059.1 45042.03333 -218.10745 45128.2 131.94078
14:33:36 45039
14:33:45 45028

68 45 -7.8998 110.0838 15:18:43 15:18:59 45080.4 45096.23333 -319.07374 45128.2 287.10707
15:19:03 45096.3
15:19:13 45112
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69 46 -7.89807 110.0794 15:47:28 15:47:45 45192.4 45128.46667 -383.05654 45128.2 383.32321
15:47:38 45004
15:48:09 45189

70 47 -7.89643 110.075 16:04:40 16:04:51 44969 44965.23333 -421.07799 45128.2 258.11132
16:04:51 44958.4
16:05:01 44968.3

71 48 -7.89477 110.0706 16:18:00 16:18:23 44855 44850.43333 -451.19118 45128.2 173.42451
16:18:29 44849.7
16:18:41 44846.6

72 49 -7.89312 110.0661 16:32:59 16:33:08 45054 45043.56667 -484.01047 45128.2 399.37714
16:33:04 45040.2
16:33:22 45036.5

73 50 -7.89143 110.0617 16:42:15 16:42:27 45010.2 45018.63333 -504.70788 45128.2 395.14122
16:42:29 45028.4
16:42:36 45017.3

74 Base -7.88653 110.1101 16:49:25 16:49:42 45309 45104.23333
16:49:42 45003.3
16:49:58 45000.4
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Data sayatan untuk pemodelan 2 ½ D

1. Data sayatan pada pemodelan AA’

No Longitude (UTM) Latitude (UTM)
Anomali Medan Magnet

(nT)
1 398448.973 9126943.379 131.5432363
2 398466.4893 9126873.314 198.4067773
3 398466.4893 9126785.732 284.4224101
4 398466.4893 9126715.667 344.3706624
5 398466.4893 9126645.602 391.351229
6 398466.4893 9126540.504 433.2809111
7 398466.4893 9126470.439 442.5018136
8 398466.4893 9126417.89 437.2751363
9 398466.4893 9126365.341 424.3161158

10 398448.973 9126330.309 399.4988233
11 398448.973 9126242.727 370.542378
12 398448.973 9126207.695 360.0989968
13 398448.973 9126137.629 340.6551079
14 398448.973 9126050.048 316.5983456
15 398448.973 9125979.983 296.6319241
16 398448.973 9125909.917 275.9752373
17 398448.973 9125787.303 243.1503996
18 398448.973 9125734.754 233.5371752
19 398448.973 9125664.689 232.1994047
20 398448.973 9125559.591 270.2512642
21 398448.973 9125489.526 298.1095072
22 398448.973 9125454.494 305.7055298
23 398448.973 9125384.428 314.4505424
24 398448.973 9125296.847 315.9356043
25 398448.973 9125261.814 315.1610622
26 398448.973 9125156.717 308.0349409
27 398448.973 9125104.168 302.6012198
28 398431.4567 9125051.619 291.829397
29 398413.9404 9124981.554 274.9157154
30 398413.9404 9124841.423 244.1204136
31 398413.9404 9124788.874 228.8229613
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2. Data sayatan pada pemodelan BB’

No Longitude (UTM) Latitude (UTM)
Anomali Medan Magnet

(nT)
1 396487.1474 9127065.993 432.6371732
2 396539.6963 9127030.961 487.0599117
3 396592.2452 9127013.444 512.7351579
4 396627.2778 9126978.412 520.8674341
5 396697.343 9126960.895 507.6890027
6 396767.4082 9126925.863 462.6006536
7 396819.9571 9126890.83 400.6314777
8 396890.0223 9126838.281 313.6204268
9 396977.6038 9126838.281 327.0958283

10 397030.1527 9126785.732 312.1971168
11 397100.2179 9126750.7 297.9044554
12 397170.2831 9126733.184 272.8741157
13 397240.3483 9126698.151 228.4084508
14 397310.4135 9126645.602 176.2148207
15 397397.995 9126610.569 137.2398186
16 397450.5439 9126593.053 134.0859451
17 397503.0928 9126558.021 143.5063552
18 397573.158 9126540.504 165.2490975
19 397625.7069 9126505.472 195.3830597
20 397695.7721 9126470.439 247.2172198
21 397748.321 9126435.406 300.2556895
22 397835.9025 9126400.374 391.3628135
23 397888.4514 9126365.341 427.3771961
24 397941.0003 9126330.309 432.0803732
25 397993.5492 9126312.792 421.5050864
26 398028.5818 9126295.276 411.6494527
27 398116.1633 126295.276 84.22504952
28 398151.1959 9126260.243 369.2658384
29 398203.7448 9126225.211 344.9659064
30 398273.81 9126172.662 308.2417795
31 398326.3589 9126155.146 296.6346053
32 398378.9078 9126137.629 301.6120008
33 398484.0056 9126120.113 359.6376234
34 398536.5545 9126067.564 375.4351075
35 398606.6197 9126032.532 397.2707361
36 398641.6523 9125997.499 396.1010584



94

37 398694.2012 9125979.983 402.3216632
38 398711.7175 9125962.466 399.9186379

3. Data sayatan pada pemodelan CC’

No Longitude (UTM) Latitude (UTM)
Anomali Medan Magnet

(nT)
1 394788.0662 9126838.281 50.95930141
2 394788.0662 9126803.249 72.585151
3 394788.0662 9126750.7 103.4722477
4 394788.0662 9126715.667 122.8553677
5 394788.0662 9126680.635 141.3791705
6 394805.5825 9126628.086 167.066289
7 394805.5825 9126593.053 183.6840814
8 394823.0988 9126505.472 221.3533722
9 394823.0988 9126452.923 239.5465728

10 394840.6151 9126417.89 252.1602214
11 394840.6151 9126365.341 264.7643255
12 394840.6151 9126330.309 271.6661988
13 394840.6151 9126277.76 279.2181204
14 394840.6151 9126207.695 286.6632671
15 394840.6151 9126155.146 291.6575118
16 394805.5825 9126102.597 288.1213557
17 394805.5825 9126032.532 295.0990548
18 394788.0662 9125979.983 285.6541751
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LAMPIRAN 3

Tahap-Tahap Pengolahan Data Magnetik

1. Pengunduhan Data Menggunakan Software Magmap 2000

a. Buka Software MagMap 2000 → klik import pilih tipe alat yang di download.

b. Kemudian save data di data user → download now.

c. Setelah download selesai pilih tipe survei yang dilakukan → klik ok

d. Simpan di file yang diinginkan → Klik ok

2. Menghitung Rata-Rata Nilai Medan Magnet Total Dan Rata-Rata Waktu

Pengukuran

Contoh perhitungan data magnetik pada titik pengukuran 2

1. Menghitung waktu rata-rata

=
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= ( : : ) + ( : : ) + ( : : )
=10:51:12

2. Menghitung anomali medan magnet rata-rata

=
= 45057.1 + 45059.8 + 45075.63= 45064.16667nT

3. Menghitung Koreksi Variasi Harian

Koreksi harian = waktu data − waktu awalwaktu akhir − waktu awal (bacaan akhir − bacaan awal)
= 10: 51: 11 − 09: 54: 0515: 35: 58 − 09: 54: 05 (45140.43333 − 45180.66667)= −6.7196

4. Mencari Nilai IGRF
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Masukkan latitude, longitude dan elevation data yang diinginkan. Pilih model

IGRF 11 kemudian pilih tanggal, bulan dan tahun awal penelitian dan tanggal, bulan

dan tahun akhir penelitian kemudian klik calculate.

5. Menghitung Anomali Intensitas Medan Magnet

Menghitung anomali intensitas medan magnet adalah dengan menggunakan

formula sebagai berikut :∆ = − − ℎ= 45064.16667 − 45128.2 − (−6.7196)= −57.31372
6. Pembuatan Peta Kontur

Setelah diperoleh nilai variasi harian dan anomaly medan magnetnya,

kemudian dibuat kontur dengan menggunakan software Surfer. Langkah-langkah

pembuatan kontur sebagai berikut :

1. Surfer dibuka kemudian File → New → Worksheet.

2. Pada kolom X diisi dengan nilai koordinat longitude, kolom Y koordinat

latitude,dan Z diisi dengan nilai anomali medan magnet.



98

3. File disimpan dalam format .dat.

4. Grid → Data → Data Lokasi (x, y, z) → Ok, maka akan menghasilkan file

tipe GRD.

5. Save Grid Data Report

6. Map → Contour Map → New Contour Map → Open data hasil Grid.

7. Pada bawah kiri Properties Manager dirubah

a. Tab General →checklist Fill Contour dan Color Scale

b. Tab Level → Fill Color →pilih spectrum warna
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8. Magpick dibuka File → Profiles → Simple → Load → Add (data yang telah

di save dalam surfer tadi (.dat)

a. Kolom data diubah menjadi “Ha”, klik Ok.

b. Files → New → Grid view → Ok ( akan muncul tampilan grid awal )

c. Files → New → Profile view → Ok

d. Options → Settings → keluar tampilan Common Parameters

e. Kolom Contour dicentang → nilai min dan max, diganti sesuai nilai data

grid pada surfer → Ok

f. Kolom Show profiles dicentang → keluar jendela Profiles plot parameter ,

klik “ plot stack profiles” → Ok

g. Kolom colored map dicentang →akan muncul tampilan “color map draw

mode” pada “Drawing mode” dirubah menjadi “simple color map” →

Ok
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h. Kolom Change palette →ganti palette type dengan “Uniform” → Ok →

muncul tampilan colour palette centang pada Equalize colors → Ok

i. Klik Ok ( akan muncul grid peta yang ke 2)

j. Profiles → Interpolate grid → Splines → pada kolom interval diganti 0.5

→kolom formatdiganti “GS  BINARY” → out files → save format .grd

(misal coba.grd) →Ok

Data medan magnetik total tersebut masih dipengaruhi oleh magnetisasi

bawah permukaan sehingga untuk langkah selanjutnya perlu dilakukan adlah

reduksi ke kutub kemudian koreksi efek regional atau kontinuasi ke atas. Dua

koreksi ini didapatkan nilainya dengan menggunakan software Magpick.

7. Reduksi Ke Kutub

Langkah-langkah reduksi ke kutub pada Software Magpick

1. File → Open → Coba.grd

2. Klik Operation → Reduction to pole → Nilai deklinasi dan inklinasi diganti

3. Output file → file with transformed field → diberi nama (missal RTP.grd)

→Ok
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8. Kontinuasi Ke Atas (Koreksi Efek Regional)

Langkah-langkah koreksi efek regional pada Software Magpick :

1. File → Open → RTP.grd

2. Klik Operation → Upward Continuation → Elevation diisi dengan perkiraaan

kedalaman target (misalnya 8)

3. File with continue field (regional), dibei nama upward 8.grd → Ok

4. File with original-continued (lokal), diberi nama downward8.grd → Ok
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5. Upward dan downward dilakukan dengan nilai bervariasi untuk mendapatkan

hasil yang sesuai.

9. Pemodelan Menggunakan Mag2DC

Pembuatan Slice dan pemodelan ini menggunakan software Surfer dan

Mag2DC. Untuk membuat data masukan kedalam software Mag2DC, kontur

anomlai medan magnet di slice terlebih dahulu menggunakan surfer.

1. Map→ Countour map → pilih jenis file *.grd yang telah di reduksi kutub dan

dilakukan pengangkatan ke atas →dibuat berwarna

2. Map → Digitize → File → Save as (Misal : Slice AA’.bln)

Setelah data Slice AA’ diperoleh kemudian buka data tersebut, hitung jarak

antara koordinat UTM data sebagai data masukan pad Mag2DC. Data

masukan adalah data jarak antar titik dan nilai anomaly medan magnet

disimpan dengan *.dat.
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3. Mag2DC dibuka → System Options → Begin a New Model →kolom Profil

Bearing diisi dengan sudit slice yang diukur searah jarum jam →Kolom

Reference height diisi 1 → Max Depth Displayed diisi kedalaman target →

Intensity diisi nilai IGRF → Declination diisi dengan nilai deklinasinya →

Inclination diisi dengan nilai inklinasinya → Initial Body Susceptibility diisi

dengan nilai subseptibilitas batuan atau mineral → Susceptibility dipilih SI →

Unit of measure diisi m.

4. Read in field data dicentang → Ok → kemudian pilih data yang sudah

disimpan dengan format *.dat.

5. Data yang terbaca adalah grafik anomaly medan magnet observasi, kemudian

data anomaly medan magnet dilakukan pemodelan untuk melihat grafik

anomaly medan magnet kalkulasi.

6. Model dibuat hingga menyerupai garis awal.

7. Kemudian hasil pemodelan disimpan dengan cara pilih System Option →Save

the current model → simpan data dengan format *.mod.

8. Untuk menyimpan model dalam bentuk jpg atau gambar maka printscreen

kemudian simpan.
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LAMPIRAN 4

Proton Precession Magnetometer

(PPM) Model : G-856X

Spesifikasi

Tanpilan : Intensitas medan magnet ditunjukkan dengan 6 digit

Resolusi : 0,1 gamma

Akurasi mutlak : 1 gamma

Waktu : Julian day

Tuning : 20.000 sampai 90.000 gamma

Toleransi gradient : 1.800 gamma per meter

Waktu pembacaan : 3 detik

Memori :5.700 pembacaan lapangan

12.500 base station

Output Interface : RS-232 interface

Output : Lintasan titik ukur, Julian day, waktu pengukuran, titik

pengukuran dan pembacaan medan magnetik terukur

Fisik : Instrument console 7 x 10,5 x 3,5 inci; 2,7 kg

Sensor 3,5 x 5 inci (9 x 13 cm), 1,8 kg

Lingkungan : 20 sampai 50 derajat celcius

Power : 8 Baterry D-cell ( 12 volt eksternal power)
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Proton Precession Magnetometer (PPM) adalah suatu sensor untuk mengukur

induksi medan magnet total. Sensor ini berisi zat cair yang kaya akan proton,

misalnya methanol atau kerosene. Di dalam sensor ini terdapat koil atau kumparan

yang melingkupi zat cair yang kaya akan proton tersebut. Koil ini dihubungkan

dengan sumber arus DC dan sirkuitpenghitung frekuensi.

Jika arus listrik dilewatkan melalui koil tersebut, maka akan timbul medan magnet

danmempolarisasikan proton pada arah koil. Pada saat arus diputus, koil akan

dihubungkandengan sirkuit penghitung frekuensi, sementara proton akan berpresisi

pada arah medanmagnet bumi. Gerakan momen magnetik proton akan menghasilkan

medan magnet siklikyang menginduksi arus ac pada kumparan selama 2 – 3 detik

sebelum proton berhentiberpresisi. Selama 2 – 3 detik ini, sirkuit penghitung

frekuensi akan mengukur frekuensipresisi proton. Nilai frekuensi presisi proton ini

dikonversi ke unit intensitas medan magnetdan ditransmisikan ke data logger yang

dapat dibaca langsung. ,

Prosedur Pengoperasian PPM Model G-856

a) Modus Operasi

1. Modus Survei :mengukur intensitas medan magnetik sebagai fungsi

ruang atau jarak. Data di memori disimpan dalam format :nilai intensitas

medan, nomor stasiun, waktu pengukuran dan nomor lintasan.

2. Modus Auto : mengukur nilai intensitas medan magnetik sebagai fungsi

waktu. Data di memori disimpan dalam format :nilai intensitas medan,

nomor stasiun, waktu, dan Julian-day.
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3. Modus Tambahan (Gradiometer) :mengukur nilai intensitasmagnetik

dari dua sensor yang terpisah secara vertikal. Hasilnya adalah harga

gradien vertikal yang bebas dari variasi waktu. Modus ini menggunakan 2

(dua) buah sensor yang dipasang terpisah secara vertikal dalam sebuah

tiang penyangga. Pengambilan data dilakukan dengan menekan tombol

‘cycle’ pada the remote start switch. Pembacaan pertama dilakukan pada

sensor bawah dan pembacaan kedua pada sensor atas. Data disimpan

secara otomatis. Format data dalam memori : Baris pertama untuk

pembacaan pertama, baris berikutnya untuk pembacaan kedua, dan

seterusnya.

b) Prosedur Operacsi

1. Memasang baterai pada console.

2. Memasang sensor di tiang penyangga.

3. Menghubungkan seluruh kabel konektor.

4. Memeriksa isi memori.

5. Melakukan tuning dengan mengambil kuat sinyal (signal strength) yang

paling kuat sesuai dengan harga medan di daerah survei.

6. Menyetel konfigurasi waktu : hari, tanggal, jam, dan menit saat

pengambilan data.

7. Menyetel konfigurasi lintasan (modus survey dan ggradiometer) dan

interval waktu pengambilan data otomatis (modus auto).

8. Mengambil data :
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- Pengambilan data dilakukan dengan operasi :

READ → STORE

- Arah sensor sesuai dengan tanda anak panah (N).

- Pengambilan data dengan modus AUTO dilaksankan di tempat

yang tetap (fixed station).

9. Mentransfer data di memori ke computer untuk pemrosesan lebih lanjut.

c) Petunjuk Singkat Pengoperasian :

1. Mengambil dan menyimpan data pembacaan :

Tekan :READ → STORE

2. Memebersihkan seluruh isi layar :

Tekan :CLEAR

3. Memanggil isi memori (pembacaan terakhir) :

Tekan :RECALL

4. Memanggil isi memori (nomor stasiun tertentu) :

Tekan :RECALL → SHIFT→ station# → station# → station#

→ENTER

5. Tuning magnetometer :

Tekan :READ → TUNE → SHIFT → # → # → ENTER

6. Menghapus data :

a. Pembacaan yang terakhir :

Tekan :READ → RECALL → ERASE → ERASE

b. Kelompok pembacaan yang terakhir :
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Tekan :RECALL → SHIFT → station# → station# → station# →

ENTER → ERASE → ERASE

c. Seluruh memori :

Tekan :RECALL → SHIFT → 0 → ENTER → ERASE → ERASE

7. Membaca waktu dan line number :

Tekan :TIME (tekan ketika pembacaan sedang ditampilkan)

8. Men set-up line number :

Tekan :TIME → SHIFT → line# → line# →line# → ENTER

9. Men set-up Julian Day :

Tekan :AUTO → TIME → SHIFT → day# → day# → day# →

ENTER

10. Men set-up Julian Day dan Time :

Tekan :AUTO → TIME → SHIFT → day# → day# → day# → hour#

→ hour# → minute# → minute# → ENTER

11. Memulai keluaran data :

Tekan :AUTO → ENTER

12. Menyetop keluaran :

Tekan :OUTPUT → CLEAR

13. Men set-up mode Auto :

Tekan :AUTO → SHIFT → Second# → Second# → ENTER

14. Menghentikan mode Auto :

Tekan :AUTO →CLEAR
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d) Daftar Fungsi Tombol, Tampilan, dan Konektor :

1. CLEAR : Membersihkan segala tampilan layar.

2. SHIFT (0) : Mengakses fungsi-fungsi tertentu.

3. ENTER : Memberikan perintah sistem untuk

melaksanakan perintah pengaksesan suatu

fungsi. Selain itu untuk menaikkan lokasi

memori yang tampil di layar (lihat

RECALL).

4. OUTPUT (1) :  Mengeluarkan data memori secara otomatis

ke piranti eksternal.

5. AUTO (2) : Memulai dan mengakhiri perekam data

secara otomatis (modus Auto).

6. ERASE (3) : Menghapus data yang terbaca terakhir,

kelompok data atau selurih data yang ad di

memori.

7. FIELD (4) :

8. TIME (5) : Mengakses clock waktu saat itu dan

menampilkan waktu saat pembacaan data

dilakukan.

9. TUNE (6) : Menampilkan dan atau menset-up tuning,

serta mengatur kuat sinyal.



110

10. RECALL (7) : Mengakses memori dan menurunkan lokasi

memori yang ditampilkan.

11. STORE (8) : Menyimpan data pembacaan dalam memori

12. READ (9) : Pembacaan harga medan

13. FIELD/TIME : Menampilkan data intensitas medan magnetik

atau waktu

14. STATION/DAY : Menampilkan nomor stasiun, Julian day, atau

nomor lintasan. Selain itu menampilkan kuat

sinyal, tuning, dan tegangan baterai.

15. Konektor : Merupakan konektor G-856 ke sensor,

perekam, printer, computer atau daya

eksternal.

e) Informasi Tambahan :

1. Baterai

Terdapat 2 jenis baterai dalam PPM G-856, yakni 8 (delapan) baterai D-

cell dan 1 (satu) buah baterai lithium. Delapan baterai D-cell

menghidupkan operasi-operasi dasar dan baterai lithium menghidupkan

clock dan memori.

2. Mengambil data dari memori

Data dari memori dapat dipindahkan ke computer dengan prosedur :

a. Hubungkan konektor dengan console dan ujung konektor yang

satu dengan port serial komputer.
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b. Buka program Magmap dan pilih option import data dari G-586.

c. Beri nama file data di komputer.

d. Tekan tombol : OUTPUT → ENTER

e. Jika transferberhasil data bisa dibuka dengan berbagai program

editing seperti notepad, wordpad, excel, dll.

3. Penyimpanan instrumen PPM G-856

- Lepas kabel sensor dari Magnetometer.

- Simpan semua komponen di shipping container untuk menjaga

dari kontaminasi magnetik.

- Jika sistem magnetometer hendak disimpan pada waktu yang lama,

lepas baterai untuk menjaga dari keterpautan elektronik atau korosi

karena kontak.

- Jangan melepas baterai lithium yang disolder di board rangkaian.

4. Perawatan dan pencarian kesalahan (trouble shooting)

LAMPIRAN 5
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Tabel Pengamnilan Data

TITIK
KOORDINAT

TIME MEDAN
MAGNET KET

X Y

Base 1

1

2

3

4

5

6

7

8

9

Dst..
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